
 

 

SIMATIC RF350M 
 

___________________ 

___________________ 

___________________ 

___________________ 

___________________ 

___________________ 

___________________ 

___________________ 

___________________ 

___________________ 

 

SIMATIC Ident 

RFID systems 
SIMATIC RF350M 

Operating Instructions 

 

  
11/2015 
C79000-G8976-C416-01 

Introduction 
 1 

 

Safety notes 
 2 

 

Description 
 3 

 

Commissioning 
 4 

 

Operation 
 5 

 

"RF350M" software 
 6 

 

Advanced functions 
 7 

 

Technical data 
 8 

 

Ordering data 
 9 

 

Appendix 
 A 

 



 

   Siemens AG 
Division Process Industries and Drives 
Postfach 48 48 
90026 NÜRNBERG 
GERMANY 

C79000-G8976-C416-01 
Ⓟ 11/2015 Subject to change 

Copyright © Siemens AG 2015. 
All rights reserved 

Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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 Introduction 1 
 

 

Purpose of this document 
These operating instructions contain information required for commissioning and using the 
SIMATIC RF350M device. 

The documentation is intended for commissioning engineers and machine operators who 
start up the application themselves and it describes the functions of the software. 

Scope of validity of this document 
This documentation is valid for the SIMATIC RF350M mobile reader and describes the 
delivery status as of 11/2015. 

Registered trademarks 
SIMATIC ®, SIMATIC NET®, SIMATIC RF ® and MOBY ® are registered trademarks of 
Siemens AG. 

Naming conventions  
The following terms/abbreviations are used synonymously in this document: 
 
Mobile reader Reader, read/write device (SLG), hand terminal, handheld 
Transponder Tag, mobile data storage (MDS), data carrier 

History 
Previous editions of these operating instructions: 
 
Edition Note 
11/2015 First edition 
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 Safety notes 2 
 

 

SIMATIC RFID products comply with the salient safety specifications to VDE/DIN, IEC, EN, 
UL and CSA. If you have questions about the validity of the installation in the planned 
environment, please contact your service representative. 

 

 NOTICE 

Forfeiture of approvals and guarantees 

Alterations to the devices are not permitted.  

Failure to observe this requirement shall constitute a revocation of the radio equipment 
approval, CE approval and manufacturer's warranty. 

 

Repairs 
 

 WARNING 

Repairs only by authorized qualified personnel  

Unauthorized opening of and improper repairs to the device may result in substantial 
damage to equipment or danger. Repairs may only be carried out by authorized qualified 
personnel. 
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 Description 3 
 

 

SIMATIC RF350M expands the RF200 and RF600 identification systems with a powerful 
mobile reader for applications in the areas of production and service. In addition, it is an 
indispensable aid for startup and testing. 

3.1 Field of application and features 

Device variants for different frequency ranges 
The SIMATIC RF350M device is available in the following variants: 

● with internal antenna 

● with connector for external antennas 

Implementation environment, field of application and features 
● Field of application 

The SIMATIC RF350M mobile reader can be used in a harsh environment. The device is 
extremely rugged and protected against spray water. The backlit display is easy to read 
even under unfavorable lighting conditions. 

● RFID system 

The SIMATIC RF350M mobile reader is intended specifically for the SIMATIC RF200 and 
RF300 RFID systems. The device can be used to process all RF300 transponders and 
ISO transponders compatible with it. 

● Transponder standards 

The device supports the following transponder standards 

– RF300 

– ISO 15693 

● Software 

The "RF350M" software is stored in non-volatile memory on an integrated flash disk and 
permits user-friendly, distributed reading and writing of all transponders named above. 
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Functions of the RF550M 
You can perform the following functions with the SIMATIC RF350M mobile reader: 

● Read tag ID (UID) 

● Read data from the transponder 

● Write data to the transponder 

● Represent and edit the data in hexadecimal and ASCII format 

● Save and load transponder data to and from a file 

● Inventory log file for UID 

● Menu prompting in English and German (switchable) 

● Password protection for writing transponders and ending the program (parameters can be 
assigned) 

For more information, refer to the section "The functions in the "Tag Editor" menu 
(Page 45)". 

Accessories 
The charging station for recharging the batteries and the connection to PCs via a USB 
interface or Ethernet must be ordered separately. This station has a charging bay for an 
additional spare battery. You will find more information on this subject in the section 
"Ordering data (Page 59)". 
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3.2 Keyboard overview 

Table 3- 1 Keypad overview of the SIMATIC RF350M 

SIMATIC RF350M Pos. Key label 

 

① LED charge indicator 

② Activator key (OK) 

③ Tab key 

④ Circle key 

⑤ 123 key 

⑥ Shift key 

⑦ Alt key 

⑧ Scan key 

⑨ Delete key 

⑩ Cancel / Esc key 

⑪ Cursor keys 

⑫ Screen key 

⑬ F key 

⑭ Abc key 

⑮ Alphanumeric keypad / function keys 

⑯ On / Off key 
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3.3 Antenna and antenna field 

Read head with integrated antenna (6GT2803-1BA00) 
The antenna is housed in the read head ① under a cover. 

 
Figure 3-1 Read head with integrated antenna 

Direction of propagation of the radio frequency field 

The read/write area for transponders is above and below the front part of the housing. 
Transponders cannot be processed from the front end. 

The figure below shows the direction of propagation of the RF field of the antenna. 

 
Figure 3-2 Propagation of the RF field 
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Read head with the option of connecting an external antenna (6GT2803-1BA10) 
The external antenna is connected via the antenna connector ② on the read head ①. 

 
Figure 3-3 Read head with the option of connecting an external antenna 

The following antennas can be connected to the RF350M reader with integrated RFID 
write/read unit and external antenna connector using an antenna connecting cable: 

● ANT 3 

● ANT 8 

● ANT 12 

● ANT 18 

● ANT 30 

You will find detailed information on the antennas and the write/read ranges of the antennas 
in the RF300 system manual. 
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 Commissioning 4 
4.1 Power supply 

4.1.1 Inserting the battery 
The battery of the SIMATIC RF350M is located on the rear of the device. The following 
instructions describe inserting the battery in the device 

Table 4- 1 Inserting the battery 

Step Picture Description 
1. 

 

Release the hook and loop fastener on the battery cov-
er on the rear of the device and open the screw below. 

2.  Raise the battery cover on the screw side and remove 
the cover. 

3. 

 

Insert the battery. Make sure that you insert the battery 
at an angle so that the contact side of the battery is 
inserted into the battery compartment first. 

4. 

 

Hook the battery cover and close it. Secure the the 
battery cover with the screw and close the hook and 
loop fastener. 
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4.1.2 Connecting the charging/docking station 
Close the charging/docking station as shown in the following figure. 

 
① Power supply (5 VDC) 
② Ethernet 
③ Mini-USB 

Figure 4-1 Connecting the charging station of the RF350M 

You can use charging/docking station to: 

● charge the SIMATIC RF350M mobile reader, 

● charge a spare battery and 

● connect the reader to the PC. 
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4.1.3 Charging the device 
Complete charging of an empty battery takes approximately 5 hours. 

Starting the charging operation 
The charging operation is started as soon as you insert the mobile reader into the charging 
station.  

 

 WARNING 

Explosion hazard when using a different charging station 

Use only the original charging station. Use of another charging station can result in 
explosions and serious personal injury. 

 

Detecting the level of charge 
When the mobile reader is in the charging station, the charging status of the device is 
indicated by the LED charging display of the reader: 

 
① LED charge indicator 

Figure 4-2 LED display of the reader 

Table 4- 2 LED charge indicator 

LED color Meaning 

  red Charge level ≤ 90%; charging active 

  Orange Charge level ≥ 90%; charging active 

  Green Charge level = 100% 

With the charging station, you can also charge a spare battery. 
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The LED charging display of the charging station indicates the charge status of the spare 
battery.  

 
① LED charge indicator 

Figure 4-3 LED display of the charging station 

4.1.4 The backup battery 
The backup battery in the SIMATIC RF350M is used to retain the application data when the 
main battery is empty. It is a rechargeable battery that is charged along with the main 
battery.  

Please note that the backup battery (in the case of an empty or removed main battery) can 
only retain the data for a few minutes. It cannot be replaced because it is permanently 
connected to the device. 

4.2 Scope of delivery handheld 
When supplied, the SIMATIC RF350M comprises the following components:  

● SIMATIC RF350M mobile reader 

● Battery 

● Hand strap 

● Input stylus as an aid to navigation on the touchscreen 
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4.3 Components of the charging/docking station 
The charging and docking station is made up of the following components: 

● Charging and docking station 

● Power supply unit including various connecting cables for EU / UK / US 

● USB cable 

4.4 Switching the device On and Off 

Requirements for startup 
The battery of the reader is charged and inserted as described in the section "Power supply 
(Page 15)". 

 

 Note 
Keep to the minimum charging time 

Before switching the device on for the first time, you must insert the reader into the charging 
unit and charge it for approximately five hours. 

 

Switching the device on/off  
To switch the reader on or off, press the On/Off button . After switching on, the power-up 
takes a few seconds. 

Automatic shutdown of the device  
The RF350M mobile reader has an automatic suspend mode to save energy. With this, the 
reader is changed to the following power statuses step-by-step: 

Table 4- 3 Factory settings: Power statuses of the reader 

Power status Mains power operation: Battery operation 
User Idle 1 minute 1 minute 
System Idle 5 minutes 2 minutes 
Suspend -- 5 minutes 

After being switched on again, the reader starts in the last active menu entry. 

You can manage the energy statuses with "Start > Settings > Control Panel > Power". For a 
detailed description of the power statuses, refer to the section "Power Management (PM) 
(Page 31)". 
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4.5 Basic settings in the operating system 
As the operating system the RF350M mobile reader uses "Microsoft Windows CE V6.0". The 
following sections describe the setting options of the operating system. 

4.5.1 Control Panel 

4.5.1.1 Control Panel 
The Control Panel contains a collection of applets to be able to access the settings of 
various system properties, to configure these properties, to change their performance 
characteristics and to enable or disable them.  

4.5.1.2 Accessing the Control Panel 
You can access the Control Panel either via the keyboard or using the touchscreen. The 
following instructions relate to access via the keyboard. Before you begin close all 
application windows on the screen. 

To open the Control Panel, follow the steps below: 

1. Press the Tab key so that the input focus is set on the start menu symbol to the left in the 
taskbar in the lower left area of the screen. 

2. Press the Activator button to open the start menu. 

3. Select the menu command "Settings" with the cursor keys. 

4. Press the right arrow of the cursor keys ring to open the "Settings" submenu. 

5. Select the menu command "Control Panel" with the cursor keys. 

6. Press the Activator key to open the Control Panel. 

4.5.1.3 Opening/closing applets 

Opening applets 
To open applets, follow the steps below: 

1. Select the required applet using the cursor keys. 

2. Press the activator button to open the applet. 

Closing applets 
To close the applet and its window, you have two options: 

● If you want to discard changes made to the configuration, press the Cancel/Esc key. 

● If you want to adopt changes you have made, press the activator key. 
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 Note 
Exceptions when closing applets 

There are exceptions to the procedure outlined, such as the applet for network connections. 
 

4.5.1.4 Closing the Control Panel 
Follow the steps below to close the Control Panel: 

1. Press the F / Mode key and then the Alt key. Following this, the "File" menu is opened in 
the Control Panel. 

2. Using the arrow down cursor key select the menu entry "Close". 

3. Press the activator key to close the Control Panel. 

4.5.1.5 Control Panel applets 

Display 
With the Display applet, you can change the representation of the window elements on the 
screen and the desktop background picture. 

Owner 
This applet is mainly for information in conjunction with user identification. To enter user 
information, the following tabs are available. 

● Identification 

Here you can specify general information (name, company and address) about the owner 
of the device. 

● Network ID 

This user information is required for access to network resources. 

ClearType 
Windows Embedded CE supports three types of text display technology. On of these is 
ClearType. A ClearType applet refers to the text display technologies as "font antialiasing". 
One of the font anti-aliasing methods is a ‘No Anti-Aliasing’. With the ClearType applet, from 
these three text display technologies you can select the best possible look for a font on the 
display. In addition, the applet gives you the option of fine-tuning the rendering method to 
improve the rendering of your chosen font even further.  

 

Note that the font rendering technology of your choice is enabled for all fonts in the system, 
the look of one font may improve but the look of another on the display may not when text is 
rendered using different fonts with the same text display technology.  
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Date/Time 
In addition to the date and time settings, with the Date/Time applet you can change to time 
zone of your device and enable or disable the automatic daylight saving time switchover. 

Input area 
With this applet you can change the appearance of the screen keyboard. 

Error Reporting 
Windows Embedded CE provides numerous technologies for calling up device status 
information at the time of a program crash. You can enable or disable this system property 
with the Error Reporting applet. You can also choose how much memory the Error Reporting 
system may use for the report file. 

Internet Options 
This is a utility for configuration of the Internet Explorer. The Internet options can also be 
called up using the "View" menu in the Internet Explorer. 

Password 
If you want to protect the reader from unauthorized access to the background system of the 
RF350M mobile reader by third parties, you can protect the device with a password using the 
Password applet. Password protection is enabled when the system is turned on or the blank 
screen is reactivated. Both situations relate to the transition from a status with low power 
consumption to the status with the highest possible power consumption; in other words the 
"On" status. If you "enable password protection for screen saver" in the Password applet and 
the blank screen (or the entire device) is turned on again due to user or system activity, you 
will be prompted to enter your password to be able to use the system again.  

To enter your password use the screen keypad to be sure of the characters that make up 
your password. Entering the password using the keypad may prove difficult if, for example 
you mix numbers, lowercase and uppercase characters. Note that you can also enter the 
password when you log on using the screen keypad. 
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Country and language settings 
The "Regional Settings" applet includes the settings for supporting the national language 
(NLS) in Windows Embedded CE and in particular the NLS implementation on the RF350M 
mobile reader. NLS is responsible for date, time, calendar, numerical and currency formats. 
The applet also provides options for selecting the user interface and input language. Support 
of these functions by the mobile reader may be restricted. 

 

 Note 
Saving changes permanently on the reader 

To save changes to the regional settings permanently on the reader so that any changes 
made are still active when you restart the device, you need to make a "Registry Backup" 
("Start > Programs > Advanced settings > Registry Backup").  

 

Volume and Sounds 
Windows Embedded CE uses sound effects to make the user aware of certain events. 
These events are divided into five categories:  

● Application sounds 

● System events and warnings 

● Alarms and reminders 

● Key strokes 

● Touchscreen actions 

The "Volume & Sounds" applet describes system events and warnings as "events" and 
alarms and reminders as "notifications". Keystrokes are referred to as "key clicks". Using the 
applet, you can allow or prevent the sound effects depending on the source. The sound 
effects of the keystrokes and touchscreen taps have a control for setting three volume levels. 
If you disable the sound effects, you mute the sound.  

The "Volume & Sounds" applet also provides the option for volume control of a loudspeaker 
that affects all sounds generated by the system. In the "Sound" tab you can enable or 
disable the event sources and the sound effects assigned to them. The tab also supports 
you when selecting a sound effect for a particular event by allowing you to listen to the 
available sounds using the relevant option. When you have selected the enabled event 
sources and their corresponding sounds, you can save your selection as a scheme file. 
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Network connections 
The applet lists all communications methods that can either establish a connection or that 
have already established a connection. As default, the applet shows the symbols "USB" and 
"NXPWLAN1" that stand for the USB interface or for the 802.11b/c compliant wireless 
receiver in the RF350M mobile reader. When you place the device in the charging station, 
the symbol "AX887721" is displayed in the applet window. This stands for the Ethernet 
interface of the charging station. Apart from the symbols mentioned above, the symbol 
"COM6" is also displayed if the USB cable of the charging station is connected to a PC, 
assuming that the PC is turned on. 

 

 Note 
Display of the interface symbols 

Note that the interface symbols "AX887721" and "COM6" are only displayed in the applet 
window when the charging station is connected to the power line. 

 

The configuration options that provide various media symbols by tapping on them twice 
apply to IP network information with the exception of the "USB" symbol. The symbol begins 
either when a connection is established or allows this connection to be terminated assuming 
it is connected. If you select the USB symbol and then select the menu element "Properties" 
in the "Connection" menu of the applet window, you obtain access to its properties. 

In practice, where you require the "Network Connections" applet to assign static IP address 
information to the interfaces "NXPWLAN1" and "AX887721", DHCP is set as default on the 
interfaces. With the "New..." option, the applet also provides the option of establishing a new 
connection (e.g. VPN or a point-to-point connection). 

 

 Note 
Access to the submenu 

Note that you can also access this applet using the "Settings" submenu in the "Start" menu. 
 

NID AutoStartSettings 
Using this applet, you can enable or disable the service that controls the system when the 
device is started up after being switched on. The purpose of the service is to start your 
business application after the network connection has been established and to maintain 
user-friendliness by both hiding unnecessary information on the screen and by preventing 
the user from interfering in the connection establishment phase by pressing keys or touching 
the screen. The applet has a help that informs you about the use of the applet. 

NID Backlight 
Using the applet for the NID Backlight, you can set the brightness of the screen and the 
keyboard background lighting in different power statuses. 
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NID Indicators 
A NID indicator provides two measuring bars on the screen. One bar shows the charge 
remaining in the battery. The other bar displays the signal strength with which the mobile 
reader communicates with the connected wireless LAN access point. The applet also 
provides for options for arranging the bars on the display. 

NID Keypad 
With the NID Keypad applet, you can assign functions to certain keys: 

● Changing a key function 

● Enabling/disabling the scan key 

● Default mode of the alphanumeric keypad, in other words numeric mode, lowercase or 
uppercase writing 

● Enabling/disabling the keylock 

NID Link Watchdog 
With this applet, you can put a service into operation for monitoring connectivity via wireless 
LAN (WLAN) or by USB. This service informs the user about an interruption of the 
connection by sounding a warning signal and displaying a corresponding message on the 
screen. As soon as a functional communications channel is available again, the message 
window disappears from the screen and a connected signal sounds.  

The purpose of this service is to improve the user-friendliness of the device particularly in the 
WLAN environment where an interruption of the connection can occur daily. One reason for 
this may be that the device is outside the range of the WLAN coverage or there is a longer 
bad signal transmission. The user therefore receives information about an interruption of the 
WLAN connection that may be difficult to recognize when there are other problems. This 
allows suitable measures to be taken immediately after interruption of the WLAN connection. 

The Link Watchdog service can only be used when the computer can be reached via the 
cable backbone network of the WLAN infrastructure. The monitoring does not require any 
special software on this computer. Only its IP address and the TCP port number for sending 
"polls" need to be set in the applet. Polling does, however, require an open TCP port on the 
computer. In addition to this, the computer must also react to TCP connection initiations. An 
alternative to the end device for monitoring connectivity is a Web server running on the 
computer. 

 

 NOTICE 

Blocking by firewall and NAT device 

If there is a firewall, a NAT device or both between the RF350M mobile reader and the 
computer sending the polls, it is possible that the service for monitoring the NAT connection 
does not work if no changes to the configuration are made on the NAT device and on the 
firewall. 

 



Commissioning  
4.5 Basic settings in the operating system 

 SIMATIC RF350M 
26 Operating Instructions, 11/2015, C79000-G8976-C416-01 

NID Menu 
The NID Menu is a support application that helps you with your work. With the NID Menu, a 
number of applications can be selected and added to a menu displayed via the desktop. The 
NID Menu provides the option of completely blocking access to the Windows desktop when 
necessary.  

In the "Settings" tab, you can specify the content of the NID Menu, add new programs and 
delete programs that are not required. You can change the order in which the programs in 
the NID Menu are displayed using the cursor keys. 

Select the "Enable Startup Menu" check box to start the NID Menu after starting up. You can 
also specify an "Unlock Password" that is required by the user to exit the NID Menu. With 
these settings, following startup the user only has access to the NID Menu and the programs 
it contains.  

You can add new programs with the "Add" button. The "New Entry" tab is opened. In this 
tab, you can search for and name the exe file for starting the program. You can also assign 
arguments for the program and specify a picture for the start button. The picture must exist in 
png format and can have a maximum size of 48 x 48 pixels. 

"Search" tab 

Table 4- 4 Setting options of the "Search" tab 

Characteristic Description 
Program Path Path of the program file 
Programm Argu-
ments 

Path of the argument 

Menu Title Title of the menu 
Picture Path Path of the symbol graphic 
Dependent on 
Network Connec-
tion 

Select this check box to only allow the application to start when a network con-
nection exists. Select this option only when a network connection is absolutely 
necessary (e.g. browser-based applications).  
If the application has an offline mode, this option should not be selected. 

Program has Cus-
tom Keymap 

Select this check box if the keyboard is adapted for the specific user using the 
MHL (Multiple Hardware Layer service / Nordic ID API) in your application. 
This setting saves the current key assignment for all open applications. This 
allows the correct use of the application at all times. If the program uses a user-
specific key assignment and this check box is not selected, problems will occur 
in other applications. 

Program Custom-
izes Scanner 
Config 

Select this check box when the application sets up scanner applications for a 
specific user using the MHL (Multiple Hardware Layer service / Nordic ID API). 
Otherwise the scanner may not function correctly for the other NID Menu appli-
cations. 

Force Fullscreen This option is only intended for applications that do not have integrated full-
screen functions. Select the check box to remove the bar of the NID Menu from 
the screen when the application starts. 

AutoStart Program Select this check box to start the selected program automatically after the device 
starts up. 

Start Topmost Select this check box to place the application window in the foreground in front 
of any other open windows. 
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NID OTF Backup 
The "NID-OTF-Backup" applet was developed to ensure the persistency of registry settings. 
In this applet, you can specify intervals at which the device makes an automatic backup of 
the registry.  

NID Power Button 
Using the "NID On/Off button" you can assign the various on/off functions to key of the virtual 
keypad.  

As default, when you press the On/Off button, the "Reboot.exe" file executes. You can save 
changes to the keypad assignment in profiles. 

NID SNTP Service 
If your business application requires that the RF350M mobile reader is synchronized with the 
time of day of your server, you can use the "NID SNTP Service" applet to make an SNTP 
client (Simple Network Time Protocol) available on the mobile reader. The SNTP client can 
obtain a time value from a source. Apart from the address of a time server, you can specify a 
destination port on which the service is available when necessary.  

To implement the SNTP client, polling parameters are also necessary. On the "Settings" tab 
of the applet, you can adapt the following parameters: 

● Update Interval 

Specifies how often the client checks the time (in minutes or hours). 

● Timeout 

Specifies how long the client waits for a server response before sending the time check 
request again. 

● Retries 

Specifies how often the attempt is repeated per update interval.  

 

This applet also provides the option of adjusting the system time of the device. For time 
queries, you can link the user dialog utility "AskTime" to the SNTP queries. To customize 
(localize) text boxes of the user interface of AskTime, there are two tabs in the applet. 

Apart from using AskTime, you are also instructed to start the SNTP client in the "Settings" 
tab. 

 

 NOTICE 

Saving the system time 

The mobile reader is equipped with a real-time clock chip. This is supplied by the 
rechargeable backup battery so that the system time is not lost during a restart. 
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NID Touch Screen 
With this applet you can activate/deactivate the touchscreen. 

PC Connection 
With this applet you can enable or disable the PC connection that is based on the Microsoft 
ActiveSync technology. The ActiveSync connection via USB is the standard medium on the 
RF350M mobile reader. 

The ActiveSync connection is only possible if you have installed Microsoft ActiveSync and 
the USB driver for the ActiveSync connection provided by Siemens on your Windows PC. 
The PC connection established via USB should then run in plug and play mode. Remember 
that you cannot connect the USB cable directly to the device. Instead, connect the USB 
cable to the charging station of the mobile reader (you will find more information on the 
charging station and USB connection in the operating instructions of the charging station).  

Power 
This applet is for the control of power status changes of the system from maximum to 
minimum power consumption. The actual control is based on the adaptation of three timeout 
periods. With all periods, the system must remain idle until the transition to a power status 
with lower power consumption is possible. After three successive idle periods, the system 
stops itself. Apart from controlling the power management of the device, the "Power" applet 
provides information on the battery status and the power status of subsystems (e.g. the 
wireless LAN adapter, audio system, barcode scanner). 

The power statuses are described in the section "Power Management (PM) (Page 31)". 

Storage Manager 
This applet is used to manage the non-volatile memory ("DSK1:") on the device. The storage 
space can be repartitioned using the applet. You can also format the entire volume after 
dismounting it and delete all the existing partitions. Or you delete just one partition in 
permanent storage.  

Stylus 
As the name "Stylus" implies, the applet makes the interfaces available for adapting your 
interaction with the touchscreen. You can calibrate the touchscreen so that it not only 
processes the double tap interaction, but also when you touch the screen with the stylus. 
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System 
The "System" applet has two informative tabs. "General" and "Copyright". As well as these 
informative tabs, the applet also has two further tabs "Memory" and "Device Name". In the 
"Memory" tab, there is a trackbar slider that regulates the usage of the RAM memory 
between program execution and storage capacity of the RAM-based file system on the 
device. The default position of the slider is suitable in normal operation. Nevertheless, 
situations may occur in which certain maintenance operations fail unexpectedly. In this case, 
adjusting the use of the RAM between the storage space of the file system and the execution 
storage space can help. 

Windows Embedded CE supports dynamic name registration on a WINS server (Windows 
Internet Naming Service). For the registration, the device needs to have a unique name in 
the network. You can specify the device name in the "Device Name" tab. 

Keypad 
With the help of this applet, the auto-repeat property of the keys on the keyboard can be 
enabled or disabled. You can also adjust the following parameters of the auto-repeat 
function: Auto-repeat delay and auto-repeat rate.  

USB Profile 
The "USB Profile" applet can be considered as a selector with which you can choose an 
operating mode of the device via the USB connection. You can put the RF350M mobile 
reader into operation via USB as follows: 

● ActiveSync 

● Mass Storage 

● RNDIS 

● Serial Port 

● Disable 

ActiveSync 

As default, the mobile reader is operated via the USB cable in ActiveSync mode. This mode 
is used to synchronize data between a local Windows desktop PC and a Windows CE device 
via a USB connection. The mode also depends on the enable/disable parameter that you 
can specify in the "PC Connection" applet of the Control Panel. 

Note that data synchronization on computers with Windows Vista is not known as 
"ActiveSync", however this data synchronization technology is part of a WMDC software 
package (Windows Mobile Device Center) of Windows Vista systems. 

Mass Storage 

If you select the "Mass Storage" option, the mobile reader is treated as a USB mass storage 
device by Windows when the reader is connected to the USB port of the computer. On the 
Windows computer, the "Flash" folder of the root directory of the Windows CE file system of 
the mobile reader is displayed. In this mode you can use the device or the flash folder of the 
device as a USB drive. 
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RNDIS 

RNDIS (Remote Network Driver Interface Specification) is the protocol on which ActiveSync 
communication is based since publication of version 4.0. The RNDIS mode on the device 
combined with ActiveSync on the local Windows PC allow an IP connection via the serial 
USB port.  

Serial Port 

If you select the option "Serial Port", the computer recognizes the device as a virtual serial 
port. 

Disable 

The USB function of the device is disabled. 

 

If you require a cable IP connection to synchronize data between the application host system 
and the mobile reader, the use of the Ethernet interface on the charging station of the mobile 
reader is recommended instead of the USB interface and your own synchronization software 
instead of the RNDIS option of the mobile reader. One reason for this is the complexity of the 
ActiveSync technology and that its remote synchronization function can conceal security 
risks. 

USB switch 
With the aid of the "USB Switch" applet, you can set the mode of the USB interface. We 
recommend that you do not change the setting. The following modes exist: 

● Automatic 

● Force client 

● Force host 

● Disable 

Dialing 
Due to the current communications options of the RF350M mobile reader , the "Dialing" 
applet is not necessary. The applet may be useful with future models. Currently, however, it 
is not possible to set dialing properties for the communications options of the device. 
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Certificates 
Windows Embedded CE provides a certificate store (this means three logical stores) for 
keeping and managing certificates. With the aid of the store and its application programming 
interface, Embedded CE applications can verify, list, call up, save and delete certificates. For 
example a configuration-free wireless subsystem when acting as supplicant uses the store 
when EAP-TLS is selected as the authentication method for wireless access. This means 
that the Certificate applet is an instrument for the following:  

● Viewing certificates and their contents in the store 

● Deleting certificates from the store 

● Adding certificates to the store 

4.5.1.6 Power Management (PM) 
In the RF350M mobile reader, settings relevant to power are controlled by the power 
management. (PM). One of the tasks of the PM is to save battery power by reducing the 
power consumption. The reason for reducing power consumption is the inactivity of the user 
or the system. For example as default, the PM reduces the screen brightness when there is 
neither input by pressing keys or using the stylus on the screen for a specified period of time. 
When, however, there is user action the PM activates the system. If, for example, if the 
screen is turned off, the PM instructs the system to turn on the screen with the adjusted 
maximum brightness if a key is pressed or the screen is touched. 

The PM is controlled by the Control Panel applet "Power (Page 28)". 

Power statuses 
The RF350M mobile reader has two essential power statuses; in other words it is either on 
or off. It can also be operated with alternating current or with a battery. From the user's point 
of view, the system has four different power statuses:  

● On 

● User Idle (display is darkened) 

● System Idle (power saving mode) 

● Suspend (standby) 

 

 NOTICE 

Definition of the "Off" status 

In this manual, "Suspend" and "Idle" relate to the "Off" status of the device; in other words 
when the mobile reader is turned off.  

 

When the mobile reader is in the idle status for a longer period of time, as default it changes 
via "User Idle" and "System Idle" to the "Suspend" status. For the transition from the "On" 
status to the "Suspend" status, the PM uses three inactivity timers. As soon as all three 
timers have expired, the PM stops the mobile reader. The device can therefore not only be 
stopped using the "Shutdown" dialog window that is called with the On/Off button. By default, 
the PM tends to change the device to the "Suspend" status to save power when it is running 
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on the battery. If the battery cover is removed, the mobile reader changes automatically to 
the "Suspend" status. You can also turn off the Mobile reader using the "Shutdown" dialog 
window regardless of the active power status; in other words, it does not matter whether the 
device is in the "On" status or in a transitional status. 

Power status "On" 
When you use the mobile reader actively, it is in the "On" status. If the device is in a different 
status from the "On" status, the PM changes the system to the "On" status as soon as you 
start to use the device and, for example turn on the stopped device. You can recognize the 
"On" status because the screen is turned on with the adjusted maximum brightness. 

The device exits this status if you turn it off or a "User Idle" timer expires. When the timer 
expires, the system changes to the power status "User Idle". If the setting "Never" is 
enabled, the timer does not expire. The device remains in the "On" status until it is turned off. 

Power status "User Idle" 
"User Idle" is a transitional status. This status serves only to reduce power consumption. At 
the same time, the device gives the impression of being still turned on. Normally the 
transition to the "Idle" status can be recognized because the screen brightness is reduced.  

You can return the device to the "On" status by touching the screen or pressing a key. 
Otherwise, after a specified timeout the device changes to the "System Idle" status in which 
the device uses less power because it switches off the screen. If, however, an application is 
running on the device for which the system needs to remain in the current power status, PM 
does not change the power status to "System Idle".  

Power status "System Idle" 
"System Idle" is a transitional status. Changing to this status is only possible when the 
system idle timer has expired. The system idle timer also has the setting "Never". If this is 
set, the system does not change to the "System Idle" status but remains in the "User Idle" 
status until the user performs an action on the device.  

Under certain circumstances, the statuses "System Idle" and "Suspend" may be difficult to 
distinguish since the power statuses appear similar from the outside. If the device appears to 
be turned off, the best thing is to press the On/Off button to change it to the "On" status. If 
the "Shutdown" dialog window appears on the screen, press the On/Off button to close the 
window. When the dialog window "Shutdown" is displayed, this indicates that the device was 
in the "System Idle" power status. 

The device remains in the "System Idle" power status and waits for the timeout of the 
Suspend timer as long as no system or user activity occurs. As soon as the Suspend timer 
expires, the device is stopped by the PM. 
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Power status "Suspend" 
When the reader is switched off, it is suspended. This is for the simple reason that the device 
cannot be turned off completely. Instead, the critical parts of the system's electronics remain 
powered after turning off the device. If the device changes via the "Shutdown" dialog window 
to "Sleep", it is suspended.  

The PM stops the device as soon as the "System Idle" status is reached and a Suspend 
timer has expired. If you set the value "Never" for the suspend timer the PM does not stop 
the mobile reader. 

You can recognize the suspended status by the blank screen and that the device does not 
react when a key is pressed. The exception to this is pressing the En/Off button that turns on 
the screen. The device therefore only exits this status when the On/Off button is pressed. 

When the device is operated with alternating current, it cannot be changed to the suspended 
status. 
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 Operation 5 
5.1 The keypad 

Table 5- 1 Keypad overview of the SIMATIC RF350M 

SIMATIC RF350M Pos. Key label 

 

① LED charge indicator  

② Activator key (OK) 

③ Tab key 

④ Circle key 

⑤ 123 key 

⑥ Shift key 

⑦ Alt key 

⑧ Scan key 

⑨ Delete key 

⑩ Cancel / Esc key 

⑪ Cursor keys 

⑫ Screen key 

⑬ F key 

⑭ Abc key 

⑮ Alphanumeric keypad / function keys 

⑯ On / Off key 

Basic functions when navigating with the keypad 
Using the keypad or the touchscreen, you can navigate within the operating system and the 
"RF350" software.  

The following keys handle the most important basic functions when navigating in the user 
interface: 

● With the Activator key, you open the selected menu or program. 

● With the Tab key, you change between the taskbar and desktop in the operating system. 

● You can assign the circle key individually with the NID keypad. 

● With the Screen key, you hide or show the screen keyboard. 
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● With the cursor keys you navigate through the user interface. 

● With the Cancel / Esc key you return to the higher-level menu/menu command. 

The following sections describe the functions of all keys in detail. 

5.1.1 Activator key (OK) 
With the Activator key, an operation is accepted or activated. In the conventional sense it 
provides the same function as the Enter key. For example, the key moves the cursor to the 
next line when writing. 

5.1.2 Cursor keys 
The cursor keys control cursor movements in editing mode and control the selection of 
entries grouped together by window elements (e.g. menus, lists or desktop icons 
representing applications or utilities). The function of the four keys can be compared to that 
of the arrow keys on a PC keyboard. 

5.1.3 Tab key 
Normally, the Tab key moves the cursor a preset number of spaces or to the next tab stop in 
text to be edited. The Tab key also has navigation properties by controlling the input focus 
movements in window elements. Input focus means that the window element with the input 
focus is enabled to receive messages from the user pressing the keys. 

5.1.4 Alt key 
The Alt key is often pressed in combination with other keys (Alt + key combination) and the 
action that results depends on the application. By pressing the Alt key various window 
menus can be called up. 

5.1.5 Delete key 
By pressing the Delete key, the character directly in front of the cursor is deleted. If you hold 
down the Delete key, several characters are deleted. Note that the key retains its delete 
function regardless of the mode of the alphanumeric keypad. 

5.1.6 Cancel / Esc key 
In general, the Cancel / Esc key cancels the selection or the currently running operation like 
an Esc key on a conventional PC keyboard. 
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5.1.7 Scan key 
Pressing the Scan key enables the scan function of the reader. All the transponders in the 
antenna field are scanned and displayed. 

5.1.8 Alphanumeric keypad / function keys 

Alphanumeric keypad 

Modes of the alphanumeric keypad 

An alphanumeric keypad can be used in four different modes: You can change between the 
keypad modes by pressing the 123 key, the Abc key or the F key. The key of the currently 
selected mode is lit white. 

In the table below, the key combinations for changing between the modes are listed.  
 
Keypad mode Key combination 
Numeric mode 123 key 
Lower-case letter mode Abc key 
Upper-case letter mode 1) Abc key (press twice) 
Function key mode F key 
 1) The Abc key is lit brighter when the upper-case letter mode is active. 

Function keys 
On the keypad of the RF350M mobile reader there are the function keys F1 to F12. After 
pressing the F key, every key of the alphanumeric keypad functions as a function key. The 
function keys can be accessed regardless of the mode of the alphanumeric keypad.  

5.1.9 On / Off key 

Turning the device on 
To turn the device on, press the On/Off button. The system is ready for operation without 
rebooting. The first time the device is uses is, however, an exception to the turn on 
procedure described here since the mobile reader initially runs a system start after pressing 
the On/Off button. 
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Turning the device off 
Requirements: The mobile reader is battery-operated and the operating system is running. 

Follow the steps below to turn the device off: 

1. Press the On/Off button. 

However, do not hold the button pressed down. The "Shutdown" dialog window is then 
displayed on the screen of the device. 

2. Press the Activator key. The system changes to the idle mode. 

The "Shutdown" window provides more options than simply shutting down the device. The 
default option changes the mobile reader to a status in which power consumption is at its 
lowest (idle mode). The key sequence "On/Off button" and "Activator key" is adequate to turn 
off the device. 

Table 5- 2 Shutdown options of the reader 

Options Description Remark 
Sleep 1) The device changes to the idle 

mode. After exiting the idle mode, the 
reader starts in the last active menu 
entry before the On/Off button was 
pressed. 

Note 1:  
The power management in the Con-
trol Panel influences the depth of the 
idle mode. For more information, 
refer to the section "Power Manage-
ment (PM) (Page 31)". 
Note 2:  
The device does not change to the 
idle mode when it is in the docking 
station. 

Warm Boot 2) The content of memory and unsaved 
registry contents are retained (includ-
ing RAM memory). All unsaved data 
in all running programs is lost. 

Note 1:  
The device retains all settings also 
those that have not been saved. 
Windows CE is simply restarted. 
Note 2:  
Some applications/functionalities 
need to be restarted so that the new 
settings are valid. 
Note 3:  
Do not reopen the PAK files. 

Cold Boot The content of the RAM memory is 
deleted and the device is reset to its 
initial status. All unsaved registry 
entries are lost. 

Note 1:  
Restart Windows CE and delete all 
the settings that have not been 
saved. 
Note 2:  
Open all PAK files. 
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Options Description Remark 
Reload Windows CE RAM is deleted and the device is 

reset to its initial status. All unsaved 
registry entries are lost. The device 
loads Windows CE from the flash 
memory into RAM. 

Note 1:  
Load Windows from the flash and 
then perform a "Cold Boot". 

Power Off The device is completely turned off. 
Select this option if you need to store 
the device for a longer period of time 
without loading it. 

Note 1:  
Mode for long-term storage to protect 
the battery from total drainage. 
Note 2:  
Wakes up "Reload Windows CE". 

 1) Default when the mobile reader is not in the charging station. 
2) Default when the mobile reader is in the charging station. 

5.2 The touchscreen 
The display of the SIMATIC RF350M is designed as a touchscreen. You can easily enter 
commands by touching it with the stylus. 

5.2.1 Stylus and touchscreen 
The simplest option for navigating through the Windows CE desktop and the window of the 
auxiliary programs is to navigate using the touchscreen. To allow you to navigate using the 
touchscreen, the RF350M mobile reader is equipped with a stylus.  

The stylus and touchscreen can be used in much the same way as a mouse. By pressing the 
stylus on the touchscreen, the same result is achieved as when clicking with the left mouse 
button on a Windows PC. Clicking with the right mouse button, on the other hand, is not as 
obvious. In the Windows CE desktop window, you click with the right mouse button by 
tapping and holding with the stylus. This procedure does not have the same effect with the 
taskbar. To "right click" the taskbar, you need to hold down the "Alt" key and tap on the 
taskbar at the same time. It therefore depends on the Windows CE application which 
sequence is selected for a right click. 
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5.2.2 Screen keypad 
Windows CE provides a control element that simulates the keypad on the touchscreen. With 
the key sequence F / Mode key and the Activator key, the screen keypad is displayed (and 
hidden). Characters are entered by tapping on the screen keys and appear in the input box 
in just the same way as when entering using the alphanumeric keypad. 

 

 Note 
Enabling/disabling the screen keypad 

Note that the availability of the screen keypad is indicated by a corresponding icon in the 
taskbar. By tapping on the icon, the screen keypad is turned on or off. 

 



 

SIMATIC RF350M 
Operating Instructions, 11/2015, C79000-G8976-C416-01 41 

 "RF350M" software 6 
6.1 Starting "RF350M" software 

After you turn on the RF350M mobile reader the first time, the "RF350M" software is started 
automatically. When you exit the "RF350M" software, you can call it up again via the desktop 
or the Start menu. 

You can access the software either using the keypad or the touchscreen. The following 
instructions relate to access via the keyboard. 

 

Starting the software using the desktop 

Follow the steps below to start the "RF350M" software using the desktop: 

1. Press the Tab key so that the input focus is set on one of the desktop icons. 

2. Select the icon the RF350M with the cursor keys. 

3. Press the activator key to start the software. 

  

Starting the software using the Start menu 

Follow the steps below to start the "RF350M" software using the Start menu: 

1. Press the Alt key so that the input focus is set on the start menu symbol to the left in the 
taskbar in the lower left area of the screen. 

2. Press the Activator button to open the start menu. 

3. Select the menu item "Programs" with the cursor keys. 

4. Press the right arrow of the cursor keys ring to open the "Programs" submenu. 

5. Select the menu command "RFID" with the cursor keys. 

6. Press the right arrow of the cursor keys to open the "RFID" submenu. 

7. Press the right arrow of the cursor keys to select the menu entry "RF350M". 

8. Press the activator key to start the software. 
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6.2 Menu overview and functions 
After the "RF350M" software has been started, the "Main Menu 1" is displayed. The main 
menu is divided into "Main Menu 1" and "Main Menu 2". 

 
Figure 6-1 "Main Menu 1" and "Main Menu 2" 

Table 6- 1 The menus of the "RF350M" software 

Menu Description 
Inventory • Starting/stopping scanning 

• Overview of the identified transponders 

Tag Editor • Starting/stopping scanning 
• Reading and writing transponder data 
• Setting the OTP function (only for RF300 transponders) 
• Initializing transponders 

Tag Info • Starting/stopping scanning 
• Information on the memory configuration and content of the transponder and 

the transponder type 

Settings • Adaptations and settings for the "RF350M" software 

Help • Contact data for Siemens Support 
• Reference to the manual in the device 

Click the "Select" button to open the selected menu. Click on "Exit" to end the "RF350M" 
software and to return to the operating system. 
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6.3 The functions in the "Inventory" menu 
In the "Inventory" menu, transponders can be identified in the antenna field of the RF350M 
and when necessary also saved in a file. 

Tag Data 
The "Tag Data" tab shows you the identified transponders. 

 
Figure 6-2 "Tag Data" tab in the "Inventory" menu 

Table 6- 2 Properties of the tag list 

Characteristic Description 
# Numbering of the transponders in the order in which the transponders were 

identified. 
Protocol Differentiation of transponder families/protocols  

• RF300 
• RF200 / ISO 15693 

UID Unique identifier of the transponder 

Buttons of the menu 
The "Inventory" menu contains the following buttons: 

● Options 

Opens the Options menu. 

● Scan 

Starts/stops scanning. 

● Back 

Returns to the main menu. 
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Options 

 
Figure 6-3 Options in the "Inventory" menu 

Table 6- 3 Options of the "Inventory" menu 

Options Description 
Start / Stop Scan-
ning 

Starts/stops scanning. 

Clear the tag list Deletes all the transponders in the transponder list. 
Log file Opens the "Log file" submenu. 

In the submenu, you can specify the properties for saving the log files. 
Inventory mode Specifies the inventory mode. 

• Normal: Counting the transponders always starts at "0". 
• Incremental: Counting the transponders starts continuing from the last count 

action. 

Tag Info Direct link to the "Tag Info" menu 
Tag Editor Direct link to the "Tag Editor" menu 
Cancel Closes the Options menu. 
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6.4 The functions in the "Tag Editor" menu 
In the "Tag Editor" menu, you can read data from a target transponder, change this and write 
to the target transponder. With RF300 transponders the configuration memory area can also 
be read and the OTP function used.  

All transponders can be initialized. During initialization the entire memory can be preset with 
value entered. 

File 
In the "File" tab, you can save read or set transponder data in the flash memory of the 
RF350M.  

 
Figure 6-4 "File" tab in the "Tag Editor" menu 

The following options are available in the "File" tab:  

● Auto-Save 

● Open 

● Save Tag 

● Save Tag As 

Auto-Save 

In the "Auto-Save" tab, you can specify in which file read or set transponder data ("Memory 
Editor" is saved automatically in the flash memory of the RF350M. 

The file "READ.XML" is a preset XML file in which the data of every read transponder is 
saved. Existing transponder data is overwritten by new read actions. If the file 
"TAG_xxx.XML" is selected, a separate XML file is created for every transponder. The value 
"xxx" is replaced by the UID of the transponder in question. 
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Open 

Click the "Open" button to load an XML file. The content of the opened file is displayed in the 
Memory Editor. With the aid of this function and the "Memory Editor" you can for example 
transfer data from one transponder to other transponders 

´Save Tag/Save Tag As 

Click the button "Save Tag/Save Tag As", to save data currently displayed in the editor of the 
RF350M to a directory on the RF350M. If you select "Save Tag", the current "READ.XML" 
file will be replaced or a new "TAG_xxx.XML" will be created. If you select "Save Tag As", 
you can select a new directory or a new file name. 

Target 
In the "Target" tab, you can scan the antenna field of the RF350M for transponders. If a scan 
has been made, the transponder type of the identifies transponder is displayed. As an 
alternative, you can select the transponder type manually. With the aid of this function and 
the "Memory Editor" you can for example transfer data from one transponder to other 
transponders 

All the functions/setting described in the following tabs only affect the transponders of the 
transponder type selected here. 

Note: The memory size of the transponder memory is shown in hexadecimal or decimal in 
the "User Memory" box. Click in front of the rectangular box to change the displayed format.  

 
Figure 6-5 "Target" tab in the "Tag Editor" menu 
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Memory Editor 
In the "Memory Editor" tab, you can read and write the memory area of the transponder. 

 
Figure 6-6 "Memory Editor" tab in the "Tag Editor" menu 

Note: You can have the "Address" and "Length" displayed in hexadecimal or decimal 
notation. Click in front of the relevant rectangular box or on the box title, to change the 
displayed format. You can display the "Data" in hexadecimal, decimal, ASCII or binary 
format. Click on the box title, the change the displayed format. 

Table 6- 4 Parameters of the "Memory Editor" tab 

Parameter Setting options Default value Description 
ID -- -- UID of the transponder 
Memory area • USER 

• OTP 1) 
• CONFIG 1) 

USER Selection of the memory area from 
which data is read out or to which 
data is written. 

Complete ☐ / ☑ ☑ Check box to read or to write to the 
complete memory area. 

Address 0 ... 255 
0 ... 0xFF 

0 Start address in bytes from which 
data is read/written. 
The maximum value depends on 
the memory size of the transpond-
er. 

Length 0 ... 65535 
0 ... 0xFFFF 

2) Number of bytes to be read or 
written starting at the start address. 
The maximum value depends on 
the memory size of the transpond-
er. 
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Parameter Setting options Default value Description 
Data • Hex 

• Dec 
• ASCII 
• Binary 

Hex Representation of the data in hex-
adecimal, decimal, ASCII or binary 
format. 

Write -- -- Writes the displayed data to the 
transponder located in the antenna 
field. 

Read -- -- Reads the data from the tran-
sponder located in the antenna 
field. 

Back -- -- Returns to the main menu. 
 1) Only with RF300 transponders 

2) Depends on the read transponder type. 

Init Tag 
In the "Init Tag" tab, you can specify a value with which the entire transponder memory can 
be written. 

 
Figure 6-7 "Init Tag" tab in the "Tag Editor" menu 

Note: You can enter "Fill characters" in hexadecimal, decimal, ASCII or binary format. Click 
on the bracket above the rectangular box to change the display format.  
 
Parameter Setting options Default value Description 
Fill characters 0 ... 65535 

0 ... 0xFFFF 
00 Byte value in hexadecimal, deci-

mal, ASCII or binary format. 

Initialize -- -- Execution of the Init command. 
Back -- -- Returns to the main menu. 
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6.5 The functions in the "Tag Info" menu 
The "Tag Info" menu reads and displays information on the memory configuration and 
content of the transponder and the transponder type. Since the reading all memory areas 
can take several seconds, you must make sure that the transponder remains permanently in 
the antenna field of the reader while reading. Make sure that during scanning, only one 
transponder is located in the antenna field. 

The data read out and its meaning are displayed. 

 
Figure 6-8 "Tag Info" menu 
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6.6 The functions in the "Settings" menu 
In the "Settings" menu, you can adapt and make settings for the "RF350M" software. 

Inventory 
In the "Inventory" tab, you can preselect which transponder families will be identified by the 
SIMATIC RF350M reader. This function makes it easier for you to work if you use both 
transponder families, but currently only want tp process one transponder of a protocol type. 

 
Figure 6-9 "Inventory" tab in the "Settings" menu 

Click on one of the check boxes if you want to enable or disable the corresponding protocol 
type. 
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Editor 
In the "Editor"tab you can specify the display formats in which the data is displayed in the tag 
editor.  

 
Figure 6-10 "Editor" tab in the "Settings" menu 

Table 6- 5 Parameters of the "Editor" tab 

Parameter Setting options Default value Description 
Data • Hex 

• Dec 
• ASCII 
• Binary 

Hex Default format for representing the 
transponder data 

Address • Hex 
• Dec 

Hex Default format for representing the 
address information 

Length • Hex 
• Dec 

Hex Default format for representing the 
length information 

Auto-Save • READ.XML 
• TAG_xxx.XML 

READ.XML Default of the Auto-Save function 
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Misc 
In the "Misc" tab, you can set a password. adapt settings for acoustic signals and specify the 
language of the "RF350M" software.  

 
Figure 6-11 "Misc" tab in the "Settings" menu 

Table 6- 6 Parameters of the "Misc" tab 

Options / parame-
ters 

Setting options Default value Description 

Passwort der 
Applikation 

-- -- Assigning a password 
If a password is assigned, you 
need to enter this to write data, to 
initialize the transponder and to 
exit the "RF350M2 software. 
To disable the password, enter the 
previous password in the "Old 
Password" box and leave the box-
es "New Password" and "Confirm 
Password" empty. 

Volume • High 
• Mid 
• Low 
• Off 

Mid Selection of the volume of the 
generated acoustic signal. 

Language • English 
• German 

English Selection of the user interface 
language of the "RF350M" soft-
ware. 
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About 
The "About" tab contains information about the versions of the "RF350M" firmware and 
software. 

 
Figure 6-12 "About" tab in the "Settings" menu 
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6.7 The "Help" menu 
In the "Help" menu, you will find further information about Siemens Support and the manual 
of the RF350M. 

 
Figure 6-13 "Help" menu 

The operating instructions of the RF350M mobile reader are stored on the reader in PDF 
format. Note that you cannot display the manual via the mobile reader.  

To open the manual, you require a computer with Acrobat Reader. You can download the 
manual via the "Siemens Industry Online Support 
(https://support.industry.siemens.com/cs/ww/en/ps/21696/man)". If the mobile reader is 
connected to the computer via the docking station, you can also copy the manual to your 
computer (path: "SIMATIC RF350M\Flash\Manuals"). 

https://support.industry.siemens.com/cs/ww/en/ps/21696/man
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 Advanced functions 7 
7.1 Saving identified transponders 

Storage of the identified transponders in the "Inventory" menu 
You can save the transponders identified in the "Inventory" menu and the inventory statistics 
in a file. In the options menu under "Log file", you can specify the file name and location of 
the file. 

 
Figure 7-1 "Log file" options menu 
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Representation of the transponder data in csv format 
The following table shows an example of how the stored transponder data is represented in 
csv format. 

Table 7- 1 Example of saved transponder data in csv format  

# Date Protocol ID 
1 7/30/2015 10:50:21 AM ISO15693 E00401004ABC1A33 
2 7/30/2015 10:50:31 AM ISO15693 E00780ABDE528560 
3 7/30/2015 10:50:38 AM ISO15693 E005000002D91E7D 
4 7/30/2015 10:50:45 AM ISO15693 E00801D7E5462A6F 
5 7/30/2015 10:50:50 AM RF300 0000000055A757D9 
6 7/30/2015 10:50:53 AM RF300 00000000955555FF 
7 7/30/2015 10:51:00 AM RF300 00000000557677FF 
8 7/30/2015 10:51:06 AM RF300 0000000055766FFE 
9 7/30/2015 10:51:10 AM RF300 0000000055BBDBFB 
10 7/30/2015 10:51:15 AM RF300 00000000557759E9 
11 7/30/2015 10:51:18 AM RF300 000000005576EA67 

7.2 Data transfer between the PC and mobile reader 
 

7.2.1 Prerequisites 
If you want to access the supplied files and documentation, note the following requirements:  

● The SIMATIC RF350M is connected to the computer in the charging/docking station and 
via the USB cable. The USB cable ships with the charging/docking station. 

7.2.2 Windows Mobile Device Center 
In Windows 7, the Windows Mobile Device Center opens automatically when a connection 
has been established via a USB cable between the RF350M and the computer. With older 
operating systems up to and including Windows XP, you also require the "ActiveSync" 
software. 

In the "File Management" menu item, you can exchange files between the RF350M and the 
computer. 
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 Technical data 8 
 

 

Table 8- 1 Technical specifications 

  6GT2803-1BA00 
6GT2803-1BA10 

Product type designation SIMATIC RF350M 
 
Radio frequency 

 

Operating frequency 13.56 MHz 
 
Electrical data 
Write/read range max. 80 mm; 

depending on transponder type 
Protocol for wireless transmission RF300-specific; 

ISO 15693,  
ISO 18000-3 

Product property, multitag capability No 
Power supply Battery operation or line power operation via a 

power supply unit or docking station (24 VDC) 
Battery Lithium-ion battery  

(7.4 V; 2600 mAh) 
Charging time  

• 0 to 90% 2.5 hours 

• 0 ... 100% 5 hours 

Backup battery  

• Storage time for RAM 8 hours 

• Storage time for real-time clock 200 days 

User program RF350M.exe 
Operating system Microsoft Windows Embedded CE 6.0 
 
Interfaces 

 

Communication with PC • USB via charging/docking station 
• LAN via charging/docking station 
• WLAN integrated in the device 
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  6GT2803-1BA00 
6GT2803-1BA10 

 
Hardware 

 

Processor ARM11, 532 MHz 
RAM 256 MB 
Flash memory 256 MB 
Display Touchscreen 3.5 ", 240 x 320 pixels 
Keypad 29 keys 
Sound Loudspeaker 
 
Mechanical specifications 

 

Weight (incl. battery)  

• Reader incl. battery 500 g 

• Loading/docking station 375 g 

Dimensions (L x W x H)  

• Reader 250 x 90 x 47 mm 

• Loading/docking station 170 x 110 x 140 mm 

Degree of protection IP54 
Material  Plastic 
Color  Black 
MTBF  
 
Permitted ambient conditions 

 

Ambient temperature  
 • During operation -20 … +55 °C 

 • During transportation and storage -20 to +60 °C (without battery) 

 • during charging 0 ... +40 °C 

Relative humidity 10 to 95%, non-condensing 
Maximum drop height 1.0 m 
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 Ordering data 9 
 

 

Table 9- 1 Ordering data RF350M 

 Article number 
SIMATIC RF350M mobile reader with internal antenna 6GT2803-1BA00 
SIMATIC RF350M mobile reader for external antennas 6GT2803-1BA10 

 

Table 9- 2 Ordering data for RF350M accessories 

 Article number 
SIMATIC RF350M charging/docking station 
incl. USB cable and power supply unit 

6GT2803-0BM00 

Spare battery RF350M 
Lithium-ion battery (7.4 V; 2600 mAh) 

6GT2803-0CA00 
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 Appendix A 
A.1 Certificates and approvals 

Table A- 1 Certificates and approvals for SIMATIC RF350M 

Certificates and approvals Description 

 
CE approval to R&TTE 

  
FCC  
Federal Communications Com-
mission  

This device complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: 
(1) This device may not cause harmful interference, and  
(2) this device must accept any interference received, including 
interference that may cause undesired operation.  
Caution  
Changes or modifications not expressly approved by the party 
responsible for compliance could void the user's authority to oper-
ate the hand-held equipment.  
Note  
This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency ener-
gy and, if not installed and used in accordance with the instruc-
tions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful inter-
ference to radio or television reception, which can be determined 
by turning the equipment off and on, the user is encouraged to try 
to correct the interference by one or more of the following 
measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for 

help. 
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Certificates and approvals Description 
RF 
Radio frequency 

This equipment complies with EU and FCC RF radiation exposure 
limits set forth for an uncontrolled environment under the following 
conditions: 
1. This equipment should be installed and operated such that a 
minimum separation distance of 20 cm is maintained between the 
antenna an user`s/nearby person`s body at all times. 
2. This equipment must not be co-located or operating in conjunc-
tion with any other antenna or transmitter. 
THE PICTURE SHOWS THE SAFE WAY TO HANDLE THE 
DEVICE. 
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Certificates and approvals Description 
Radio modules The device contains an approved radio module. 

This module is identified below. 
Module: SDC-SSD40NBT 
FCC ID: TWG-SDCSSD40NBT 

  
IC 
Industry Canada 

This device complies with Industry Canada’s licence-exempt 
RSSs. Operation is subject to the following two conditions: 
(1) This device may not cause interference; and  
(2) This device must accept any interference, including interfer-
ence that may cause undesired operation of the device. 
Le présent appareil est conforme aux CNR d’Industrie Canada 
applicables aux appareils radio exempts de licence. L’exploitation 
est autorisée aux deux conditions suivantes : 
1) l’appareil ne doit pas produire de brouillage; 
2) l’utilisateur de l’appareil doit accepter tout brouillage radioélec-
trique subi, même si le brouillage est susceptible d’en compromet-
tre le fonctionnement. 
This Class B digital apparatus complies with Canadian ICES-003. 
Cet appareil numérique de la classe B est conforme à la norme 
NMB-003 du Canada. 
The device for operation in the band 5150–5250 MHz is only for 
indoor use to reduce the potential for harmful interference to co-
channel mobile satellite systems. 
Les dispositifs fonctionnant dans la bande de 5 150 à 5 250 MHz 
sont réservés uniquement pour une utilisation à l'intérieur afin de 
réduire les risques de brouillage préjudiciable aux systèmes de 
satellites mobiles utilisant les mêmes canaux. 

Radio modules The device contains an approved radio module. 
This module is identified below. 
Module: SDC-SSD40NBT 
IC ID: 6616A- SDCSSD40NBT 

  
ETL 
Electrical safety listing 

ETL listed, Intertek 4004039 
Conforms to UL STD 60950-1 
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A.2 Service & Support 

Technical Support  
You can reach technical support for all PD projects as follows: 

● Phone: + 49 (0) 911 895 7222 

● Fax: + 49 (0) 911 895 7223 

● E-mail (mailto:support.automation@siemens.com) 

● Internet: Web form for support request 
(https://support.industry.siemens.com/My/ww/en/requests) 

Contacts  
If you have any further questions on the use of our products, please contact one of our 
representatives at your local Siemens office.  

The addresses are found on the following pages: 

● On the Internet (http://w3.siemens.com/aspa_app) 

● In Catalog CA 01 

● In the catalog ID 10 specially for Industrial Identification Systems 

Service & Support for Process Industries and Drives 
On the Internet, on the Support home page (https://support.industry.siemens.com/cs/de/en/) 
of Process Industries and Drives (PD), you will find various services.  

There you will find the following information, for example: 

● Our newsletter containing up-to-date information on your products. 

● Relevant documentation for your application, which you can access via the search 
function in "Product Support". 

● A forum for global information exchange by users and specialists. 

● Your local contact for PD. 

● Information about on-site service, repairs, and spare parts. Much more can be found 
under "Our service offer". 

RFID homepage 
For general information about our identification systems, visit RFID home page 
(http://w3.siemens.com/mcms/identification-systems/). 

mailto:support.automation@siemens.com
https://support.industry.siemens.com/My/ww/en/requests
http://w3.siemens.com/aspa_app
https://support.industry.siemens.com/cs/de/en/
http://w3.siemens.com/mcms/identification-systems/
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Online catalog and ordering system  
The online catalog and the online ordering system can also be found on the Industry Mall 
home page (https://mall.industry.siemens.com). 

Training center    
We offer appropriate courses to get you started. Please contact your local training center or 
the central training center in  

D-90327 Nuremberg. 

Phone: +49 (0) 180 523 56 11 
(€ 0.14 /min. from the German landline network, deviating mobile communications prices are 
possible) 

For information about courses, see the SITRAIN home page 
(http://sitrain.automation.siemens.com/sitrainworld/). 

https://mall.industry.siemens.com/
http://sitrain.automation.siemens.com/sitrainworld/
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